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* Always wear personal protective equipment when making direct contact with participants*

Physiological Measures of Arousal

Background

The following document outlines the procedures for measuring physiological arousal.  Physiological arousal can occur from a variety of circumstances, whether the event that causes them is physical (ie. exertion such as exercise) or mental (ie. being frightened). The company iworx manufactures several instruments designed to measure such arousal responses.  Below are common proxies for arousal with codes beside them representing specific iworx instruments.

· Galvanic Skin Response (GSR-200)
· Respiration (RM-204)
· Heart Rate (PT-100)
· Blood Pressure (BP-600)
· Temperature (TM-100)
 
	Typically, with increased levels of arousal, any or all of these measures may increase. For further 	technical information, including data analysis and calibration procedures, refer to the manuals 	associated with each instrument, copies of which have been included in this document on pages 	4 through 17, or contact the supplier at http://www.iworx.com/


Protocol

In the interest of inclusiveness and cultural sensitivity, what researchers will require of participants should be made as transparent as possible.  In particular, during recruitment the following script should be used and should include a link to this SOP.

"The researchers wish to be inclusive in their recruitment process. This project requires the placement of medical sensors on the head and body by a male researcher. Participants will take part individually or in pairs. If for any reason you may feel uncomfortable taking part, please contact the researcher to discuss modifications to the procedure to address your concerns. Please see a copy of the SOP describing the procedure at <link>"


For each individual measure of arousal, the researcher should...


1). Include a diagram or pictures for the purpose of informed consent which displays where/how the instrument will be worn.  See Figure 1 on p.3 for an example.

2). Don latex free, nitrile gloves.

3). Explain the process to the participant and obtain their consent verbally prior to affixing any instruments, including what each device does and where/how it will be worn.  For each instrument, the explanation and procedure is outlined below.  These explanations should also be present on any written consent forms.

	3a). Galvanic skin response sensors measure micro changes in the conductance of 	electricity across the surface of the skin.  As people become aroused, they sweat, which 	increases the conductivity.  The sensors will be gently strapped to any two adjacent 	fingers of either hand via Velcro. 

	3b). A pulse plethysmograph is a small clip on device used to measure changes in 	peripheral pulse.  This can be used to obtain a heart rate, or when used in conjunction 	with a blood pressure cuff it can help to measure blood pressure.  The pulse 	plethysmograph should be gently clipped onto any finger tip not occupied by galvanic 	skin response sensors.

	3c). The sphygmomanometer (blood pressure cuff) is used to measure blood pressure 	and is similar to one that a physician would use.  The cuff should be wrapped around the 	upper arm, mid-humerous, such that the sensor, as indicated by an arrow on the cuff, is 	directly over the brachial artery.  Clothing should be removed or sleeves rolled up such 	that the cuff can have proper contact with the skin.  The pulse plethysmograph should be 	attached to a finger on the same arm from which blood pressure is being taken.  Inform 	the participant that you will be inflating the cuff, and if they should experience any 	discomfort to alert you immediately (at which point you will deflate the cuff completely and 	cease the procedure).  If the participant knows their normal blood pressure, inflate to 20 	mm Hg higher than their typical systolic pressure.  If they do not know, do not inflate to 	more than 160 mm Hg.  Release the pressure slowly at a rate of 10 mm Hg / second.

	3d). The respiration monitor consists of an elasticized band with a pressure sensor 	meant to be worn around the torso and measures the rate and depth at which the 	participant breathes.  The monitor should be worn over clothing, and does not 	necessitate the wearing of any particular clothing (i.e. loose or tight) and the fact that it is 	worn over as opposed to under clothing should be made clear to participants during the 	consent process.  It should be placed below the sternum, at approximate height with 	the participant's elbows.  It should fit snugly, but not so tight as to cause discomfort.  	Ask the participant if it feels comfortable.

	3e). The temperature sensor can  assess a participant's temperature in a non-invasive 	manner by placing a probe on the surface of the skin to measure skin temperature.  	Conversely, it may be placed under the nose to measure temperature changes in nasal 	airflow.  If it is necessary, tape may be used to ensure proper attachment of the sensor.  	Medical grade, latex free IV tape is recommended.  Participants should be screened for 	allergies to adhesives during the recruitment phase and the consent process, and this 	should be verbally confirmed before placement of any tape. If tape is required, the sensor 	should be placed in a location that is relatively hair free, such as the inside of the 	forearm, or directly behind the ear. For participants who appear to have an excessive 	amount of hair, tape should not be used.  If a participant is wearing a head dress of any 	kind consider an alternative placement of the sensor.  If an alternative cannot be used, 	ask the participant if they would feel comfortable removing their head dress.  This point 	should also be iterated through the consent process. Be mindful of cultural and religious 	beliefs.


4). After each use, all equipment must be cleaned.  In particular, any equipment that makes direct contact with the skin or other parts of the body should be rinsed, gently washed in warm, soapy water, rinsed once more, and finally wiped down with isopropyl alcohol and left to dry.  For instruments where it is not acceptable to get them excessively wet, it may be appropriate to wipe them down with a damp cloth rather than submerge them.  Examination gloves should be disposed of after each use.


*Note: this is not a medical diagnosis, and it should be made clear to the participants that the researcher is not a health care professional.  Individual results should not be provided to participants or interpreted under any circumstances.  Participants should seek the advice of a physician should they have concerns about their measurements.  This should be clearly stated on the consent form.*
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Figure 1. Example diagram to be included in consent process.


BP-600 Noninvasive Blood Pressure Sensor
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BP-600

Overview
A person's cardiac output, peripheral vascular resistance, blood pressure, and
other cardiovascular parameters change in response to the activities and events
taking place in the person's daily schedule. A device like the BP-600 Noninvasive
Blood Pressure Sensor makes it easy to study the changes in blood pressure that
take place over the course of an event or an activity. The BP-600 has two major
components: a blood pressure cuff used to occlude the flow of blood in a subject's
brachial artery; and a pressure transducer used to monitor the pressures in the cuff
that correspond to the systolic and diastolic blood pressures. The output of the
pressure transducer is a voltage that can be recorded by an iWorx data acquisition
unit and converted into units of pressure (mmHg) by calibration.
After blood flow in the subject's arm is occluded, the pressure is released from the
cuff by another student who is listening for the return of pulsatile blood flow in the
arm. The first Korotkoff sound to be heard occurs at the systolic pressure and the
last Korotkoff sound is at the diastolic pressure. To make it easier for students to
find the systolic and diastolic pressures, the output of a pulse transducer attached
to the subject's finger can be used to indicate the presence or absence of blood
flow in the arm before, during, and after the occlusion of the subject's brachial
artery. 

How It Works 
When the blood pressure cuff is placed on a subject's upper arm and inflated to a
pressure above that person's systolic pressure, blood flow to the lower arm is
occluded so that a pulse wave will not be seen when a pulse plethysmograph is
used. As pressure is released from the cuff, the output of the pressure transducer
will go down. Blood will begin to flow as the pressure in the cuff falls below the
subject's systolic pressure. The pressure at which the pulse is first seen on the 
recording from the pulse plethysmograph can be identified on the recording by a
mark that labels the systolic pressure. As the pressure continues to be released
from the cuff and the output of the pressure continues to go down, the amplitude of
the pulse wave increases up to a maximum. The pressure at which the first
maximum amplitude pulse wave is seen during the release of pressure from the
cuff is the diastolic pressure.

How to Use the BP-600

Equipment Setup
Plug the DIN connector of the BP-600 into the extension cable. Plug the extension
cable into a DIN8 transducer input of an iWorx data acquisition unit or amplifier.

Calibration of the BP-600
1) Put the blood pressure cuff on the upper arm of the subject. Align the arrow on
the cuff over the subject's brachial artery. Place the plethysmograph on the
distal segment of the middle finger. Wrap the Velcro strap around the end of the
finger to hold the unit firmly in place.
2) Click Record and record the output of the BP-600 for five seconds. Type "70
mmHg" on the comment line to the right of the Mark button. Continue recording.
3) Increase the pressure in the cuff to 70 mmHg and press the Enter key on the
keyboard. Hold the pressure in the cuff at this level for another five seconds.
Type "140 mmHg" on the comment line. Continue recording.
4) Increase the pressure in the cuff to 140 mmHg and press the Enter key on the
keyboard. Hold the pressure in the cuff at this level for another five seconds.
5) Click the Stop button. Release all the pressure from the blood pressure cuff.
6) Use the Display Time icons on the LabScribe2 toolbar to adjust the time 
displayed on the Main window so that the complete block of calibration data
can be viewed on the screen
7) Click the 2-Cursor icon so that two blue vertical lines appear on the Main
window. Place one cursor on the section of the recording marked as "70
mmHg" and the second cursor on the section of the recording marked as "140
mmHg".
8) Right-click on the data area of the blood pressure channel to open its right-click
menu. Select Units from this menu and Simple from the submenu to open the
Units Conversion dialog window.
9) Perform a two-point calibration by selecting 2 point cal from the pull-down
menu at the top of the dialog window. The voltages at the positions of the two
cursors are already entered on the window.
10)  Change the values in the boxes to the right of these voltages to the
corresponding calibration pressures, 70 and 140. Change the units to mmHg.
Click OK and the units on the Y-axis of the blood pressure channel change. 

Using the BP-600 Blood Pressure Sensor with a pulse
plethysmograph 
1) Click Record to begin recording the subject's pulse wave and the pressure in
the cuff of the blood pressure sensor. Inflate the blood pressure cuff until the
finger pulse wave on the pulse channel disappears.
2) Once the pulse wave disappears, release the cuff pressure at the rate of 10
mmHg per second. Continue to release the cuff pressure until the aneuroid
gauge reads 0 mmHg. Click the Stop button.
3) Scroll to the section of data recorded while the pressure in the cuff was being
released. Use the Display Time icons on the LabScribe2 toolbar to display the
data that includes the reappearance of the pulse wave and its return to
maximum amplitude on one screen.
4) Click the 1 Cursor icon on the LabScribe2 toolbar to place a single blue cursor
on the window.
5) On the pulse channel, find the first detectable pulse wave that occurs as
pressure is released from the cuff. Place the cursor over this pulse wave.
6) The pressure in the cuff during this particular pulse wave is equal to the systolic
blood pressure of the subject. Look in the upper right corner of the data window
for the blood pressure channel to find the systolic blood pressure. It is listed
next to the label Value (V).
7) To the right of the cursor, the amplitude of the pulse wave increases as the
pressure in the cuff decreases. In this sequence of progressively larger pulse
waves, find the first pulse wave that has the greatest amplitude. Place the
single cursor on the peak of this pulse wave.
8) The pressure in the cuff during this particular pulse wave is equal to the
diastolic blood pressure of the subject. Look in the upper right corner of the
data window for the blood pressure channel to find the diastolic blood pressure.
It is listed next to the label Value (V).
9) See the sample LabScribe2 recording on the next page. It shows the BP-600
and pulse plethysmograph channels with two cursors indicating the systolic and
diastolic blood pressures. 

Experiments 
LabScribe2 experiments using the BP-600 Noninvasive Blood Pressure Sensor
include:
Experiment HC-1: Blood Pressure, Peripheral Circulation, and Body 
Position (found in the Human Circulation category of the LabScribe2
Settings menu as BloodPressure-BodyPosition-LS2)
Experiment HC-2: Blood Pressure, Peripheral Circulation, and Imposed
Conditions (found in the Human Circulation category of the LabScribe2 
Settings menu as BloodPressure-ImposedConditions-LS2)
Experiment HC-5: Body Position, Exercise, and Cardiac Output (found in 
the Human Circulation category of the LabScribe2 Settings menu as
CardiacOutput-LS2)
Experiment HC-4: Pulse Contour Analysis (found in the Human
Circulation category of the LabScribe2 Settings menu as 
PulseContourAnalysis-LS2)

Technical Data and Specifications
SPECIFICATIONS
Impedance <900 ohms O
Sensitivity 5µV/V/mmHg
Excitation Voltage +4VDC
Output Connector DIN8
Operating Pressure +0.50 to +300mmHg
Temperature Effect +0.25mmHg/°C
Power From DIN8 input of iWorx amplifier or A/D unit






iWorx Systems, Inc. 62 Littleworth Road, Dover, New Hampshire 03820
(T) 800-234-1757 / 603-742-2492 (F) 603-742-2455
RM-204 Respiration Monitor
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RM-204

Overview
The RM-204 Respiration Monitor is a transducer used to measure the relative
depth and frequency of breathing in a human subject during experiments where it
is impractical to monitor breathing with a spirometer. For example, the use of a
spirometer to monitor breathing during a psychological test could be a distraction
that affects the results of the test. If the subject is not familiar or comfortable with
breathing through a spirometer, the subject cannot focus on completing the test.
The RM-204 permits breathing rates and relative amplitudes to be measured
easily, accurately, and unobtrusively while the subject performs another task. 

How It Works
The RM-204 Respiration Monitor has two components: a piezo-electric sensor that
produces a voltage in response to movement; and an elastic belt that is placed
around the chest to hold the sensor in place. 

The primary driving force for pulmonary ventilation is the diaphragm, the large
muscle between the thoracic and abdominal cavities. During inhalation, the
diaphragm contracts, moves downward, and forces the abdominal wall to move
outward. The process is reversed during exhalation. The piezo-electric sensor in
the RM-204 detects the cyclic movement of the ventral body wall and generates a
voltage that is proportional to the amount of movement. 

Piezo-electric sensors are devices that generate a voltage in response to motion.
When a piezo-electric sensor stops moving or is moving slowly, the voltage output
of the sensor returns to its baseline level within milliseconds. To make this motion
detector suitable for breath monitoring, the sensor of the RM-204 is fitted with a
filter that slows the return of the voltage to its baseline level. Because of the filter,
the RM-204 is able to record breath rates from 4 to 100 breaths per minute.
However, when the subject is holding his or her breath, the voltage output of the
sensor decreases very slowly. This decrease occurs because the filter cannot hold
its voltage level indefinitely and still respond to subtle changes in breathing. 



How to Use the RM-204

Caution: Do not bend the sensor element in the cloth pouch! Bending
will permanently damage the sensor. 
Equipment Setup
1) Plug the DIN8 connector of the RM-204 into a DIN8 transducer input of an
iWorx data acquisition unit or amplifier. 
2) Wrap the elastic belt of the respiration monitor around the subject's chest at a
level that is below the sternum. 
3) Place the sensor inside the belt so that the sensor is in the center of the chest
at a level that is even with the subject's elbows. The cloth pouch should be
placed inside the belt so the Velcro strip on the pouch is facing the inside of the
belt.
 
Start the Software 
When using an iWorx data acquisition system with DIN8 transducer inputs or an
iWorx amplifier:
1) Open LabScribe2 by double-clicking on the LabScribe2 icon.
2) When the program opens, select Preferences from the Edit menu (or from the 
LabScribe2 menu on a Macintosh computer).
3) Select the Channel preferences dialog window. Name the channel to which the 
RM-204 is connected. Set the Mode/Function for this channel to DIN8. Also,
set the sampling rate and display time. Click OK. 

Experiments 
Preconfigured LabScribe2 experiments using the RM-204 Respiration Monitor
include:
Experiment HS-5: Breathing Techniques and Heart Rate (found in the 
Human Spirometry category of the LabScribe2 Settings menu as
BreathingTechniques-HeartRate-LS2)


















iWorx Systems, Inc. 62 Littleworth Road, Dover, New Hampshire 03820
(T) 800-234-1757 / 603-742-2492 (F) 603-742-24
GSR-200 Galvanic Skin Response Amplifier
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GSR-200

Overview
As a person's psychological state changes in response to events in the
environment, the electrical properties of the person's skin change due to minute
changes in perspiration. These electrodermal responses can be detected by the
GSR-200. Since human skin is a good conductor of electricity, a weak electrical
current applied to the skin can determine the resistance of the skin, or its reciprocal
which is conductance.

The GSR-200 applies a constant, imperceptible voltage between two electrodes
attached to the skin. Since the voltage is constant, the current flowing between the
electrodes is proportional to the skin conductance, or inversely proportional to the
skin resistance. The GSR-200 is able to detect the current flowing between the
electrodes and convert it to a voltage that can be recorded. Using a conversion
factor, the recorded voltage is easily converted into conductance units known as
microSiemens (µS).

How to Use the GSR-200

Equipment Setup:
Plug the DIN8 cable into a transducer input of an iWorx data acquisition unit or
amplifier.
Start the Software: 
1) Open LabScribe2 by clicking on the LabScribe2 desktop icon.
2) When the program opens, select Preferences from the Edit menu (or from the 
LabScribe2 menu on a Macintosh computer).
3) Select the Channel preferences dialog window. Name the channel to which the 
GSR-200 is connected. Set the Mode/Function for this channel to DIN8. Also,
set the sampling rate and display time. Click OK. 

Calibration and Units Conversion  
The GSR-200 is factory calibrated so that an output of 1 Volt is equal to 5
microSiemens (µS).
The basis of this conversion factor follows:
The GSR amplifier records changes in skin conductance. Conductance (G), as
expressed in units known as Siemens, is the inverse of Resistance (R):
G = 1/R
The GSR-200 applies a voltage of 200mV across the resistance being measured,
so that the Current (I) flowing across the skin from one electrode to the other is
equal to applied voltage divided by the resistance:
I = 200mv/R = 200mV*G

In the GSR amplifier, the Current (I) flows through a 1megOhm feedback resistor to
produce the Output Voltage (Vout), so that: G = V out  / 0.200V * 1megOhm

Since 1 megOhm is the reciprocal of 1 µSiemen, the Conductance (G), in
µSiemens, is equal to 5 times the Output Voltage: G (in µSiemens) = 5 * Vout

Therefore, 1 Volt of output equals 5 µSiemens. This relationship along with the
Units Conversion function of the iWorx data acquisition system can be used to
convert the voltages recorded from the subject to conductance (measured in
µSiemens).

To apply this conversion factor to your recording:
1) Right-click in the recording window of the GSR-200. Select Units from the right-
click menu and select Simple from the Units submenu.
2) Select 2 point cal from the pull-down menu in the upper-left corner of the Units 
Conversion dialog window.
3) Enter “zero” in both the upper data boxes. Enter “1” in the left lower data box 
and “5” in the right lower data box. 
4) Enter the name of the units, µSiemens, in the Unit Name box. Click OK to 
activate the unit conversion. 

Operating the GSR-200
1) Attach the conductivity electrodes to the subject. Use the Velcro straps to
secure the metal discs to the pads of two adjacent fingers. 
2) Attach the other end of the electrode cable to the BNC input of the GSR-200.
Begin recording.
3) It may be necessary to adjust the offset to zero in LabScribe2. 

Experiments
LabScribe2 experiments using the GSR-200 include:
Experiment HP-2: Galvanic Skin Response and Emotion (found in the
Human Psychophysiology category of the LabScribe2 Settings 
menu as GSR-A)
Experiment HP-3: The Galvanic Skin Response, Deception, 
Cognitive Complexity, and Vigilance (found in the Human
Psychophysiology category of the LabScribe2 Settings menu as
GSR-B). 
Experiment HP-8: The Galvanic Skin Response (GSR) and
Investigation into “Cheating” (found in the Human 
Psychophysiology category of the LabScribe2 Settings menu as
GSR-Investigation) 
Experiment HP-7: Interference of Stimuli on Associative Tasks - The
Stroop Effect (found in the Human Psychophysiology category of 
the LabScribe2 Settings menu as StroopEffect) 

Technical Data and Specifications
SPECIFICATIONS
Input Impedance 10 gigohm
Input Connector BNC
Working Voltage 200 mV
Output Connector DIN8
Output Voltage Swing +4 Volts
Bandwidth DC to 3 Hz
Noise 1 mV p-p
CMR 100dB @ 60 Hz
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PO2-100D Pulse Oximeter
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PO2-100D

Overview
One of the best methods for monitoring the cardio-pulmonary condition of a patient
in a hospital or an athlete in training is the measurement of the subject's blood
gases, oxygen, and carbon dioxide. The process is invasive and requires the use
of an expensive device known as a blood gas analyzer. An alternate method of
determining the amount of oxygen in blood is pulse oximetry. This method is easy
and noninvasive, and can be performed with a simple device like the PO2-100D
Pulse Oximeter that has a sensor that clips over the end of the subject's finger or
toe. 

How It Works
The PO2-100D Pulse Oximeter measures the amount of oxygen in blood indirectly
by determining the oxygen saturation level (SpO2) of the hemoglobin in blood.
Hemoglobin exists in the blood in two different forms, oxygenated (oxyhemoglobin)
and deoxygenated (deoxyhemoglobin). Oxygenated hemoglobin absorbs more
infrared light and allows more red light to pass; whereas, deoxygenated
hemoglobin absorbs more red light and allows more infrared light to pass. 

Therefore, the absorbance of each wavelength of light depends on the saturation
or desaturation of hemoglobin, and can be used to determine the oxygen
saturation level of the hemoglobin. 

The sensor of the PO2-100D emits wavelengths of light at 600nm (Red) and
925nm (Infrared), and then detects the absorbance of those wavelengths by the
hemoglobin in the blood. Through the programming built into the PO2-100D, the
absorbance of light at each wavelength is used to determine the ratio between the
concentrations of oxygenated and deoxygenated hemoglobin in the blood. After
conversion of the output of the PO2-100D to the proper units, the level of oxygen in
the blood is expressed as the percentage of oxygen saturation. Normally, the
oxygen saturation level of blood is between 95 and 100%.

How to Use the PO2-100D

Equipment Setup
1) Plug one end of the DIN8 cable into the DIN8 connector of the PO2-100D
oximeter. Plug the other end of the same cable into a transducer input of an
iWorx data acquisition system. 
2) Connect one end of a BNC-BNC cable to the BNC output of the PO2-100D and
the other end of the BNC-BNC cable to a BNC input of an iWorx data
acquisition system. 
3) Clip the sensor over the end of the subject's middle or ring finger. An embossed
diagram on the sensor indicates the position of the finger within the clip. The
indicator light on the pulse oximeter will stop blinking in a few seconds when the
sensor is positioned and working properly. 

Warnings
The PO2-100D sensor will not work properly when placed over fingernails coated
with any shade of nail polish, or over artificial nails. Also, make sure the center of
the nail is aligned under the light-emitting diode of the sensor when the clip is
placed on the finger or toe. 

Unit Conversions
The output of the PO2-100D Pulse Oximeter is a voltage that can be converted to
a percentage. If the output is recorded using an iWorx data acquisition unit and
LabScribe2 software, the output can be converted from voltage to the percentage
of oxygen saturation in the blood using the following steps:
1) Make sure the sensor is placed on the subject's finger correctly. The indicator 
light of the pulse oximeter will stop blinking after a few seconds when the unit is
working properly. 
2) Click on the Record button in the upper right corner of the LabScribe2 Main
window. Record from the subject for about ten seconds. Click on the Stop
button. Two blue cursors should appear on the Main window. 
3) Right-click on the recording area of the Oxygen Saturation channel to open
that channel's right-click menu. Select Units from the menu and Simple from
the submenu to open the Units Conversion dialog window. 
4) Pull down the menu in the upper left corner of the Units Conversion dialog
window and select slope & offset. Set the slope equal to 10, the offset equal
to 80, and the Name of the units for the Y-axis equal to %O2 Sat. Put a check
in the box next to Apply units to all blocks. Click on the OK button. 

Heart Rate Measurements
Since the sensor of the PO2-100D also functions as a pulse plethysmograph, the
pulse signal can be used to determine the subject's heart rate. If the PO2-100D is
used with an iWorx data acquisition unit and LabScribe software, the pulse signal
can be used to compute and display the subject's heart rate on another channel: 
1) On the LabScribe2 Main window, open the Edit menu and select Preferences
from the menu. The Preferences dialog window will open onto the Channels
page. 
2) Click on the title of an unused channel, and title the channel Heart Rate. Click
the OK button at the bottom of the window to return to the Main window. 
3) Right-click on the recording area of the new Heart Rate channel to open the
channel's right-click menu. Select Periodic from the menu and Rate from the
submenu. 
4) Right-click on the recording area of the Heart Rate channel to open the
channel's right-click menu, for a second time. Select Set Raw Ch from the
menu and the Pulse channel from the submenu. 
5) While recording the pulse, heart rate, and oxygen saturation data, click on the
AutoScale button for the Pulse channel; and then click on the AutoScale
button for the Heart Rate channel to display the subject's heart rate. 

Experiments
LabScribe2 experiments using the PO2-100D Pulse Oximeter include:
Experiment HE-3: Exercise, Blood Pressure, and Oxygen Saturation 
Levels (found in the Human Exercise category of the Settings menu as
O2Saturation-Exercise-LS2) 
Experiment HC-5: Effects of Temperature on Peripheral Oxygen
Saturation Levels (found in the Human Circulation category of the 
LabScribe2 Settings menu as ECG-PulseOx-LS2)

Accuracy
Oxygen saturation (SpO2) data is valid across a pulse rate range from 18 to 300
beats per minute. SpO2 data is reported on a beat-to-beat basis with a maximum
update rate of three data points per second. 

Operation and Storage Environment
The device is designed to operate in a 0 to 50 oC environment with 10-90% noncondensing humidity. The device may be stored in an environment from -30 to 50°C with 10-95% noncondensing humidity.

Safety
The sensor meets the IEC 60601-1 Dielectric Withstand specification.
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TM-100 Temperature Sensor
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TM-100

Overview
The TM-100 Temperature Sensor is a sensor that can monitor temperatures
between 15°C above and 15°C below room temperature. The TM-100 is capable of
responding to changes in temperature within a few seconds because of its small
size (1mm x 3mm) and mass. The TM-100 is suitable for monitoring the
temperature of nasal airflow, changes in skin temperature that indicate evaporative
cooling, and changes in atmospheric temperature and temperature in
environmental chambers. Since the sensor element is water-resistant, the tip of the
TM-100 can be immersed in aqueous solutions, including saline solutions, for a
few hours. 

How It Works
The sensor element in the TM-100 that responds to temperature changes is a
thermistor, which is a type of resistor that changes resistance with changes in
temperature. The thermistor in the TM-100 has a negative temperature coefficient
(NTC) which means that the resistance of the thermistor decreases as the
temperature goes up. Thermistors with positive temperature coefficients also exist.
Table 1 at the end of this Technical Note shows the resistances of the thermistor in
the TM-100 over a range of temperatures from 0°C to 50°C.
The thermistor in the TM-100 is wired into the circuit of the sensor as one leg of a
Wheatstone bridge. On the other three legs of the bridge circuit, selected resistors
are used to give the TM-100 a linear output over a range that is 15°C above and
below room temperature. 

How to Use the TM-100

Equipment Setup
1) Insert the DIN8 connector of the TM-100 temperature sensor into a DIN8
extension cable. 
2) Insert the other end of the DIN8 extension cable into a DIN8 transducer input
on an iWorx data acquisition unit or amplifier.
Start the Software 
1) Open LabScribe2 by clicking on the LabScribe2 desktop icon.
2) When the program opens, select Preferences from the Edit menu (or from 
the LabScribe2 menu on a Macintosh computer).
3) Select the Channel preferences dialog window. Name the channel to which 
the TM-100 is connected. Set the Mode/Function for this channel to DIN8.
Also, set the sampling rate and display time. Click OK.

Calibration of the TM-100 Temperature Sensor
1) Prepare two beakers of water, one at 10 oC, and the other at 40 C. Measure
the temperature of the cold water with a thermometer just before the TM-100
temperature sensor is placed in the beaker. 
2) Place the tip of the TM-100 temperature sensor in the center of the beaker of
cold water. 
3) Click the Start button on the Main window of the LabScribe2 software and
begin recording. Type Calibration at <Cold Water Temperature> on the
comment line to the right of the Mark button. 
4) After about twenty seconds in the cold water, the output of the TM-100
temperature sensor displayed on the recording channel should reach a stable
level. Press the Enter key on the keyboard to mark the recording. Continue
recording. 
5) Measure the temperature of the warm water with a thermometer just before the
TM-100 temperature sensor is placed in the beaker. Type Calibration at
<Warm Water Temperature> on the comment line. 
6) Continue recording as the temperature sensor is moved from the cold water to
the warm water. 
7) After about twenty seconds in the warm water, the output of the TM-100
temperature sensor displayed on the recording channel should reach a stable
level. Press the Enter key on the keyboard to mark the recording. Click Stop
to halt the recording. 
8) Select Save As in the File menu, and type a name for the file. Choose a
destination on the computer in which to save the file. Click on Save to save
the file.
9) Compress the data from the calibration recording onto the same computer
screen by clicking on the Double Display Time icon on the LabScribe toolbar.
The output of the sensor at the two temperatures should be positioned on the
same screen. 
10) Click the 2-Cursor icon and position the first cursor on the plateau of the first
temperature (~10°C) and the second cursor on the plateau of the second
temperature (~40°C).
11) Right-click in the recording window of the temperature channel. Select Units
from the right-click menu and Simple from the Units submenu.
In the Units Conversion dialog window, select 2 point cal from the pull-
down menu in the upper-left corner of the window.
Put a check mark in the box next to Apply Units to All Blocks.
Notice that the voltages from the positions of the cursors are automatically 
entered into the value equations.
Enter the cold water temperature in the corresponding box to the right of 
the voltage recorded when the sensor was in the cold water. Enter the
warm water temperature in the corresponding box to the right of the
voltage recorded when the sensor was in the warm water. 
Enter the name of the units, o C, in the box below the temperatures. Click
OK to activate the unit conversion. 

Operating the TM-100 Temperature Sensor
Once the TM-100 temperature sensor is calibrated, it can be immersed in
aqueous solutions, including saline solutions, for a few hours. The TM-100 is 
not designed for long-term immersion or chronic implantation.
The rugged Teflon jacket over the sensor can also be attached with tape or 
glue to a surface to be measured.
The TM-100 is a low impedance (~10kO) sensor, so its cable can be extended 
to nearly any length without signal degradation.
Do not attempt to measure temperatures above 125°C. Temperatures above
this limit will damage the sensor. 

Experiments
LabScribe2 experiments that use the TM-100 include:
Experiment HE-1: Metabolic and Thermal Response to Exercise (found in 
the Human Exercise category of the LabScribe2 Settings menu as
MetabolicThermalResponse-Exercise-LS2)

Care of the TM-100 Temperature Sensor
Since the jacket covering the element and the insulation on the wires are made of
Teflon, they may be cleaned with just about any cleaner. 

Table 1: Resistances of the Thermistor Used in the TM-100 Temperature
Sensor at Different Temperatures 

Temp  Resistance 	Temp  Resistance	Temp  Resistance
(°C)	   (O)		(°C)	   (O) 		(°C)	   (O)
1 	31032.1 	18 	13679.8 	35 	6531.31
2 	29499.9 	19 	13070.4 	36 	6265.75
3 	28052.4 	20 	12491.6 	37 	6016.47
4 	26684.6 	21 	11941.6 	38 	5776.05
5 	25391.2 	22 	11418.9 	39 	5546.53
6 	24168.2 	23 	10922.0 	40 	5327.34
7	23011.2 	24 	10449.5 	41 	5117.97
8 	21916.3 	25 	10000.0 	42 	4917.94
9 	20879.8 	26 	9572.32 	43 	4726.77
10 	19898.3 	27 	9165.29 	44 	4543.91
11 	18968.6 	28 	8777.79 	45 	4369.33
12 	18087.6 	29 	8408.68 	46 	4200.84
13 	17252.6 	30 	8057.31 	47 	4040.81
14 	16460.9 	31 	7722.43 	48 	3889.51
15 	15710.0 	32 	7403.29 	49 	3743.17
16 	14997.7 	33 	7098.42 	50 	3603.10
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